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1.Введение 

         Настоящая инструкция описывает процедуру ввода в пакет “UNIVERS” 
данных ВСП, ГИС, наземной сейсморазведки 2D/3D 

2.Общие сведения 

          Все исходные сейсмические данные, как правило, поставляются в формате 
SEGY.  Но допустимы и другие форматы данных. Программа ввода сейсмических 
данных автоматически определяет формат входного файла (форматы SEGY, 
SDS-3-PC, SDS-3-IBM, VSP-PC, SDS-5-SUN, UNIVERS, GITAS, SEG-2, MIRF-4). 
Возможно так же ввести файл любого другого формата, если указать для него 
необходимые данные. 
          Все данные ГИС поставляются в формате LAS. Возможно так же ввести 
файл в табличном виде. 
          Введенные сейсмические данные хранятся в файлах во внутреннем 
формате пакета UNIVERS, а параметрические данные в таблицах внутренней 
базы данных. 
          Каждый ПВ обрабатывается самостоятельно.  
 

3.Ввод данных ВСП 

          Ввод данных начинается со знакомством с исходными данными. До этого 
должны быть известны следующие данные: 

• Альтитуда устья скважины 

• Альтитуда нуля кабельных глубин 

• Высота стола ротора относительно устья скважины 

• Инклинометрия скважины 

• Количество пунктов возбуждения на каждом ПВ 

• Азимут и удаление каждого пункта возбуждения на ПВ от устья скважины 

• Превышения каждого пункта возбуждения на ПВ относительно устья 
скважины 

• Количество приборов в глубинном зонде. Количество компонент в приборе 
и расстояние между приборами в зонде 

• Нумерация каналов в полевом материале 
          Все эти сведения должны содержаться в отчете о полевых работах, 
рапортах оператора и в топографической ведомости. 
 
3.1 Создание таблиц описания геометрии скважины - Well data geometry 
                                                     Description 
 

Программа, с помощью которой можно создать все необходимые таблицы, 
вызывается кликом Data import ->Well data geometry description в главном меню 
пакета UNIVERS.  
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Рис.1 Окно описания геометрии скважины 

 
            3.1.1 Таблица описания скважины -Well 
          Работа над любым проектом в пакете начинается с создания таблицы 
описания скважины. Вызывается окно кнопкой Well  
  

 
Рис. 2 Таблица описания скважины 

 
              В этой таблице заполняются все поля. Автоматически создается таблица 
инклинометрии скважины в которой описывается вертикальная скважина глубиной 
25000 метров. Если имеются данные инклинометрии, они вводятся кнопкой 
Set incl->Make new inclinometry->Load from ASCII. Данные должны быть 
представлены в виде таблицы в текстовом формате (.txt). Таблица должна 
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начинаться со значения кабельной глубины равной нулю,.не иметь пробелов 
между строками и содержать колонки: 

• Кабельная глубина 

• Зенитный угол 

• Магнитный азимут (должно быть указано магнитное склонение). Если 
азимут не указан для всех точек кабельной глубины, он должен быть 
прописан. Причем это значение не может быть одинаковым (скважина уйдет 
в этом направлении) а чередоваться в разные стороны (0, 180). 

             Дополнительно в таблице инклинометрии могут быть колонки отклонения 
скважины X, Y и вертикальной глубины Z. В этом случае предпочтительно вводить 
Hcab, X, Y, Z а не угол и азимут, из-за различной аппроксимации полиномом 
исходных данных. 

 
Рис. 3 Таблица ввода инклинометрии 

 
                   3.1.2 Таблица описания групп приборов - Zonde 
     
               В пакете UNIVERS под зондом понимается  любая группа приборов, как 
наземных так и глубинных. В таблице описывается отдельно гуппа приборов 
скважинного зонда и наземных контрольных приборов. Шаг между приборами 
глубинного зонда может быть положительным или отрицательным. Все зависит от 
способа подключения зонда к сейсмостанции. Если подключается первым самый 
нижний прибор зонда, тогда шаг между приборами положителен, если же первым 
подключен верхний прибор, шаг отрицателен. 
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Рис. 4 Таблица описания групп приборов 

 
                3.1.3 Таблицы описания положения ПВ – Sh_hole 

 
         При работах ВСП положение ПВ относительно устья скважины задается 
азимутом (не магнитным), удалением и превышением. Данные эти дает 
топограф. Если в рапорте оператора указывается несколько точек 
возбуждения (взрывных скважин) на одном ПВ, каждая из них должна быть 
описана. 
Такое описание положения ПВ относительно скважины пригодно, если 
количество ПВ не большое. Если количество ПВ больше, они обычно задаются 
значением координат и альтитудой. При этом нужно иметь в виду, что в 
таблице описания скважины (Рис. 2) должны быть тоже указаны координаты в 
этой же системе. На представленном рисунке они разные, т.к. взяты из разных 
проектов. В пакете UNIVERS возможно смешанное описание положения ПВ, 
тогда счет номеров ПВ идет от описания с азимутом и удалением. 
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Рис. 5 Таблица описания положения ПВ при ВСП 

 
3.1.4 Таблицы описания геометрии 2D/3D – Geometry 

 
При вводе наземных данных 2D/3D заполняются все таблицы Shot, Station, 
Relation, Field report.  Также создается таблица оглавления файла/файлов 
наземных данных Data import ->Scan 2D/3D seismic file contents. Программой 
Select2D можно выбрать для обработки часть имеющихся наземных данных. 



    

                          

                    ООО «ГЕОВЕРС» 
        Ввод данных в пакет UNIVERS 
                           Версия 1.0 

 

 9 

 
Рис. 6 Таблица описания положения ПВ координатами 

 
                3.1.5 Таблица описания контрольных приборов – Ch_hole 
 
            Программа создания таблицы описания положения контрольных 
приборов вызывается кнопкой Ch_hole  
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Рис. 7 Таблица описания контрольных приборов 

 
             3.1.5 Таблица описания методики наблюдений ВСП - Method 
 
           Под выражением «методика» понимается описание содержания 
магнитограмм, зарегистрированных в поле. В этой таблице указывается тип 
трассы (служебная, контрольный прибор, глубинный прибор, наземный 
прибор), номер зонда, компонента прибора, номер трассы в полевой МГ и в 
магнитограмме созданной в пакете UNIVERS (не все трассы полевой МГ могут 
быть использованы при обработке). Любое изменение канальности глубинного 
прибора,  изменения нумерации трасс в МГ должны быть описаны в отдельной 
таблице «методики».  Если исходные данные представлены в разных файлах и 
в них номера полевых МГ одинаковы и разные номера трасс, то можно описать 
их одной методикой и собрать в один файл. 
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Рис. 8 Таблица описания методики наблюдений ВСП 

 

3.1.6 Таблица описания списка наблюденных магнитограмм – LSMG 

 
         В этой таблице приводится список магнитограмм, зарегистрированных в 
поле. Для каждой магнитограммы указывается из какого ПВ, на какой глубине 
произведено возбуждение колебаний, на какой глубине были расположены 
глубинные приборы и по какой методике были подключены все каналы. В пакете 
UNIVERS предусмотрено автоматическое создание этой таблицы. Для этого до 
нажатия кнопки LSMG, нужно открыть исходный файл программой Data import-
>Well data import и затем в появившемся окне после загрузки файла: 

• Указать в каком слове заголовка трасс записана кабельная глубина прибора 
зонда View -> Data. Обычно это значение записывается в 11-м 
четырехбайтовом слове заголовка. Если номер слова с кабельной глубиной 
достоверно не известен, можно найти его самостоятельно вызвав окно 
просмотра содержимого заголовка, кликнув на кнопку View dump Рис. 10.. 

• Просмотр содержимого файла View->Content. В этом окне проверяют 
отсутствие одинаковых номеров МГ в колонке Fmg и количество трасс в 
каждой магнитограмме. Одинаковых номеров трасс в магнитограмме быть 



    

                          

                    ООО «ГЕОВЕРС» 
        Ввод данных в пакет UNIVERS 
                           Версия 1.0 

 

 12 

не должно. Для записи таблицы нужно кликнуть на кнопку LSMG Рис.11. 
Если такая таблица в проекте уже создавалось, можно дописать данные в 
уже существующую таблицу или записать ее как новую. В таблицу 
записываются только номера МГ и кабельные глубины. Все остальные 
колонки нужно заполнить дополнительно.  

 

 
Рис.9 Указание слова в заголовке с записью глубины 
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Рис. 10 Просмотр содержимого заголовка трассы 
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Рис. 11 Запись макета таблицы списка магнитограмм 

 
3.2 Ввод сейсмических данных – Data import -> Well data import 
 
          После заполнения всех таблиц, можно приступить к присвоению заголовков 
трассам. Если исходные данные представлены в нескольких файлах, ввод их 
осуществляется по очереди. Файлы данных ВСП и 2D/3D загружаются разными 
кнопками: File -> Load File, File -> Load 3D соответственно. Перед загрузкой 
данных 2D/3D необходимо редактором базы данных отредактировать таблицу 
VSP.LSMGDATALIST.  
 
3.2.1 Присвоение заголовков трассам – Headering 
           
           Для присвоения заголовков трассам существует несколько возможностей в 
зависимости от вида исходных данных. Наиболее часто применяются следующие 
режимы: 

• Manual – присвоение заголовков вручную. Каждой трассе файла 
приписывается трасса из списка,  составленного из таблиц Method и LSMG. 

• Auto – присвоение заголовков автоматически, когда номера МГ и номера 
трасс в файле полностью соответствуют номерам в списке 

• Section – присвоение заголовков трасс временным разрезам 2D. 
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Рис.12 Присвоение заголовков трассам 
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3.2.1.1 Присвоение заголовков вручную – Manual 

 
          Когда в исходном файле присутствуют одинаковые номера МГ или в одной 
МГ есть одинаковые номера трасс нужно указать каждой трассе списка 
соответствующую трассу в файле. После нажатия кнопки Manual появляется 
дополнительно окно списка трасс в проекте. 
 

 
Рис. 13 Присвоение заголовков вручную 

 
        Порядок работы с окнами следующий: 

• В левом окне есть стрелка, указывающая на трассу в файле. В правом окне 
нужно выделить средней кнопкой мыши соответствующую трассу в списке и 
нажать кнопку Sel.Traces в правом окне. После этого в левом и правом 
окнах напротив выделенной трасы появятся соответствующие подписи. В 
правом окне можно выделить не только одну трассу но и группу трасс, если 
в списке трасс и в файле они идут последовательно. 

• Действия, описанные в предыдущем пункте нужно повторять, пока не 
исчерпается список трасс или сам исходный файл.  Есть возможность 
ускорить присвоение заголовков: для этого нужно выделить первую МГ, в 
которой нужные трассы идентифицированы. Выделение трасс 
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производится средней кнопкой мыши на левом окне. Против выделенных 
трасс появятся синие точки и внизу окна появится кнопка Copy Block. 
Синюю стрелку переводим на первую трассу новой МГ, номер которой 
указываем далее. Кликнув на эту кнопку, и заполнив поля в окне Block copy, 
получим заданное количество МГ, у которых  идентифицированы 
выделенные трассы. При этом нужно учитывать, что номера новых МГ 
должны возрастать без разрывов.   

 

3.2.1.2 Автоматическое присвоение заголовков – Auto 

 
         Если в файле нет одинаковых номеров МГ и внутри каждой МГ нет 
повторяющихся номеров трасс, можно применить автоматическое присвоение 
заголовков. В этом режиме программа присвоит каждой трассе файла параметры 
соответствующей трассы из списка трасс в проекте. 
 

3.2.1.3 Присвоение заголовков трассам временных разрезов – 
Section 

         Перед вводом трасс временного разреза, нужно убедиться в том, что в 
заголовках исходного файла содержатся координаты каждой трассы. В исходном 
файле формата SEGY они обычно находятся в 19 – 22 словах заголовка. В 
формате SEGY оси X, Y соответствуют долготе и широте, а в пакете UNIVERS оси 
X, Y соответствуют  широте и долготе. Если они находятся в другом месте, 
координаты нужно перенести в слова 19 – 22 или занести их в заголовки трасс 
полученной модификации дополнительно. 
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Рис. 14 Присвоение заголовков временным разрезам 

 

3.2.1.4 Наборы данных, состоящих из нескольких файлов 
 
           Если данные состоят из нескольких файлов,  присваиваются заголовки 
трассам каждого файла последовательно. После завершения работы с одним 
файлом, вводится следующий, трассам которого также присваиваются заголовки 
процедурой аналогичной для предыдущего файла. 

 


